Outline

About this reference guide ................................................................................................................................................. 2
Open Dreamweaver ........................................................................................................................................................................ 2
Workspace Setup ........................................................................................................................................................................... 3
Main Screen .................................................................................................................................................................................... 3
Recommendations for Software Setup ................................................................................................................................. 4
   Toolbars ......................................................................................................................................................................................... 4
   Layout Tools .................................................................................................................................................................................. 4
   Properties panel for formatting ............................................................................................................................................... 4
   Default Browser.......................................................................................................................................................................... 5
Keyboard Shortcuts .......................................................................................................................................................................... 6
   Popular shortcut commands ................................................................................................................................................... 6
Document View/Design Choices .................................................................................................................................................. 6
   Design .................................................................................................................................................................................................. 6
   Split ................................................................................................................................................................................................... 6
   Code .................................................................................................................................................................................................. 7
Creating a basic webpage ............................................................................................................................................................. 7
   Title your webpage ................................................................................................................................................................. 7
Modifying Page Colors / Fonts .................................................................................................................................................. 8
Formatting and Manipulating Text ........................................................................................................................................... 8
   Bold and Italic Print .............................................................................................................................................................. 8
   Headings ....................................................................................................................................................................................... 8
Line Spacing ................................................................................................................................................................................ 9
Save a webpage .............................................................................................................................................................................. 9
   Asterisk * in file name ............................................................................................................................................................ 9
   Saving several pages.............................................................................................................................................................. 10
   File extensions - html or htm? ................................................................................................................................................. 10
Have several pages open ............................................................................................................................................................. 10
Lists and Special Characters ....................................................................................................................................................... 10
   Lists .................................................................................................................................................................................................. 10
   Special Characters ................................................................................................................................................................. 11
Insert Hyperlinks, Images, Tables, etc. ....................................................................................................................................... 12
About this reference guide

This reference guide touches on common features used in web design. It is not intended to be all inclusive. Enrollment in web design classes or self study is highly recommended.

Open Dreamweaver

Click Start – navigate to Specialized Software – Adobe – Macromedia Dreamweaver 8. It may take awhile to install (first time used). This is normal.
Workspace Setup
The very first screen you may look like this. This comes up the first time you open Dreamweaver. Pick one of the following:

**Designer** is tailored towards visual designing. This is the option most people will use.

**Coder** is tailored for programmers—those who want to work primarily with XHTML and other Web/programming languages.

After you originally choose the setup you desire, it can be changed at any time by clicking Window-Workspace.

Main Screen
This screen can be used to create new pages.

You may open previously created pages by clicking the Open... button.

Note: If you don’t care for this screen, you can click on the “Don’t show again” checkbox.

Then click File-Open to open files or File-New to create new files.

Note: If you get rid of this main screen, but then want it back, click Edit-Preferences. Use the General tab and put a checkmark in “show startup page.”
Recommendations for Software Setup

Toolbars
If you have not already started creating a new document, click File-New to create a new document. Click View-Toolbars and make sure “Insert,” “Document,” and “Standard” are available.

Layout Tools
Click Window and make sure to click on “Insert,” “Properties,” and “Files.” This will ensure the following screen features are available:

“Insert” provides tools in the form of shortcut icons, such as the ability to easily insert images, tables, etc.

Properties panel for formatting
If this isn’t open in your Dreamweaver screen, click Window-Properties to open it. This area allows you quick formatting options such as highlighting text and using the Bold or Italic features, centering, linking, changing colors, etc.

“Files” ensures you are able to view your local site files in this panel.
Default Browser
As you create pages, you will be able to preview your webpage to see how it will look once it is published. You will have to save your page prior to previewing it. Preview by clicking on the “globe” icon.

By default, Internet Explorer is set as the primary web browser for previewing.
To change this, click on Edit-Preferences. Use the Category listing “Preview in Browser.”

Add a browser by clicking the + sign
Delete a browser by highlighting it and clicking the - sign

Highlight the browser you wish to use as your primary browser and click the checkbox in front of Primary Browser.
Keyboard Shortcuts
Familiarize yourself to keyboard shortcuts by clicking on Edit-Keyboard Shortcuts, which will show you all shortcuts available.

Popular shortcut commands
Use Control N to create a new XHTML page
Use Control S to save a page
Use Control Z to undo an action or keystroke
Press the Shift key plus the Enter key to force single spacing

Document View/Design Choices
There are three icons which allow a choice for how you wish to design your pages – Code, Split, or Design. A description of each follows ~ you can choose which option(s) work best for you!

Design
Using this option you will see no coding at all. This screen shows you an approximation of how the page will look once it is on the web. Note that this is only a guide to the visual characteristics of the page. To see how the page truly looks, you will need to use the Preview in Browser button found in the title toolbar.

Split
Using this option you will see a split screen. The top portion shows XHTML code and the bottom portion shows design view.
> It is often helpful to examine code if something isn’t working correctly.
Dreamweaver Reference Guide

Code
Using the option called Code, you will see XHTML code only.

Creating a basic webpage
Click File-New. Choose Basic Page.

Title your webpage
The toolbar directly underneath the text menus contains the Title toolbar. Enter the title for your page in the space provided.

Adding a title to your page is important! The title shows in the Internet browser window once your page is published. If a title is not added, the browser window would say "Untitled Page."

In addition, if someone bookmarks your page, their bookmark will show the title.
Modifying Page Colors / Fonts
Click the Page Properties button in the Properties window to edit background color, specify different colors for fonts, links, etc. (This can also be done by clicking on Modify and choose Page Properties from the menu bar.)

Formatting and Manipulating Text
Use the *Properties window* to assist with formatting.

Bold and Italic Print
Similar to formatting options available in Word and Excel, the properties panel may be used for bolding and italicizing text, centering, adding bullet points, etc.

Headings
Use headings 1 through 6 to format various sections of your text. Headings can be found under the Format dropdown in the Properties panel. Select a heading and type your text. If you forget to apply a heading to your typed text, highlight the text and choose heading.

- Use of headings greatly helps web visitors using screen readers. Screen readers don't "look" at Web pages - they read XHTML code. If a piece of text is identified as a heading, the screen reader will announce that it's a heading. If not, screen reader users won't be able to tell your headings from the rest of your text. They will have to listen to the page in its entirely rather than having the option to jump from one main heading to another.

```
heading 1
heading 2
heading 3
```
Line Spacing
As you type, text will be wrapped automatically and you will have single spacing. Pressing the Enter key will insert a new paragraph and give you double spacing. To control spacing, i.e., if you wish to type a line and only want single spacing for the next line, follow these steps:
- Type a line.
- Press Shift key plus the Enter key. You will now control the spacing to be single spaced.
- Press the Enter key when you are ready to insert a new paragraph.

Save a webpage
Your page will say “Untitled” until it is saved and given a name. When ready to save, click File-Save As (or hold Control key down and press S). Type a name for your page and click the Save button.
- Reminder: Home pages must be named index.html or index.htm
- Reminder: If your page name contains more than one word, type words together with no space, or add an underline between names. Examples: page1.html or page_one.html

Asterisk * in file name
An asterisk next to a file name indicates there have been changes made to the page and it needs to be saved. Once saved, the asterisk will disappear.

8/5/2008
Copyright, Office of Technology, Bloomsburg University
Saving several pages
Have several pages open? Save them all at once by clicking File-Save All!

File extensions - html or htm?
Either extension is fine to use but it is suggested you pick one and use that consistently. Lowercase is also suggested, i.e., index.html

Have several pages open
You may have the need to open several pages to work on them concurrently. Once they are open, you will see tabs available for the different documents you have open. You can switch back and forth by clicking on a tab.

Lists and Special Characters

Lists
The circled items below assist with creation of lists. The most commonly used lists are UL (unordered lists, also known as bullet points) and OL (ordered lists, also known as numbered lists). Examples below.

Sample ~ UL
- computers
- desks
- chairs

Sample ~ OL
1. computers
2. desks
3. chairs

NOTE: To use lists, follow one of the following steps:
1) Type the list first. When finished, highlight all the text and use the list buttons.
2) Click on the list button and then begin typing your list. As you press Enter to go to the next item a new bullet point or number will be inserted for you.
Special Characters

If you have need of special characters, you may want to use the Text menu on the Insert Toolbar. (If not visible, click on View-Toolbars-Insert.) The circled items below provide the ability to use special features or insert symbols. They are described below.

**abbc**

If typing an abbreviation on your webpage, you can use the abbc button so when someone rolls their mouse over the abbreviation a little popup appears with what the abbreviation stands for.

- Type the abbreviation – highlight it and click the abbc button. A popup window will appear where you can type in the full meaning.

**w3c**

If typing an acronym on your webpage, you can use the w3c button so when someone rolls their mouse over the acronym a little popup appears with what it stands for.

- Type the acronym – highlight it and click the w3c button. A popup window will appear where you can type in the full meaning.

**Special Characters or Symbols (last button on the toolbar)**

Click on the little arrow next to the last symbol. This is where you will find special characters, such as copyright or trademark. Here are just a few symbols you will find. Have fun experimenting!  

© ® ™ £ — §
Dreamweaver Reference Guide

Insert Hyperlinks, Images, Tables, etc.
A great formatting tool is the Common tab on the Insert menu as circled below. This tutorial will cover the basic features you may use.

Create hyperlink to a web page
Add a hyperlink by typing a line of text. Highlight the word or phrase you wish to use as a link, and click the hyperlink icon.

The following window will appear:

Click OK when done. Your hyperlink is in place!

Another way to link
Highlight the text you wish to use and use the properties window – the link and target areas are indicated in the screen shot below.

Editing a link
Probably the easiest way is to use the properties window as illustrated in the screen shot above.
Create hyperlink to a document

Type a line of text. Highlight the word or phrase you wish to use as a link to a document, and click the hyperlink icon.

The following window will appear:

Click OK when done. Your hyperlink is in place.

Another way to link

Highlight the text you wish to use and use the properties window – the link and target areas are indicated in the screen shot below. Click on the file folder icon in the properties panel to browse to the document you wish to link to.

Editing a link

Probably the easiest way is to use the properties window as illustrated in the screen shot above. Edit the link under the link area.

Create email address hyperlink

Type your line of text. Example: Additional questions should be directed to Jane Doe. Highlight the name and click the email link icon
The following screen appears.

[Image of the Email Link dialog box with Text: Jane Doe and E-Mail: jdoe@bloomu.edu]

Text - Type the name you wish to appear as the link.
E-Mail – Type the email address for the link.

Click OK when done. Your hyperlink is in place.

Another way to link
Highlight the text you wish to use and use the properties window – the link and target areas are indicated in the screen shot below. In the link area, type the email address, preceded by the word “mailto” – Example: mailto:jdoe@bloomu.edu

[Image of the Properties window with Link: mailto:jdoe@bloomu.edu highlighted]

Editing a link
The easiest way is to use the properties window as illustrated in the screen shot above.
Inserting Images

Images should always be resized prior to adding them to a webpage!

- **Images should never be larger than 800 x 600 pixels**

You may use the Common toolbar to insert images into a page (or click Insert-Image from the menu bar). Be at the location where you would like to insert the image - click the insert image icon.

The following window appears. You will need to navigate to the image you wish to insert. Click okay when you find the image and are ready to insert it.

When you click OK, this screen appears – so you may enter Alternate Text. This is text that will display in browser windows when someone rolls their mouse cursor over the picture. For accessibility purposes, this is the text that is read to those using screen readers. Try to add text that is short and to the point.

If you don’t want to enter this information when inserting objects, change the Accessibility preferences.
**Dreamweaver Reference Guide**

**Good practices when inserting images**

After inserting an image on your page, click on the photo. The following should be defined in the Properties panel:

- Width attribute for photo
- Height attribute for photo
- Alt text (for screen readers)

**Link Image to a website or document**

After inserting an image on your page, if you wish to have people click on the image to be directed to another webpage or document, follow these steps.

Click on the photo.

In the properties window

**Linking to a webpage** – enter link here

**Linking to a document** - click on the folder to browse to the Document you wish to link to.

**Inserting Tables**

Tables may be used for page layout purposes (control how page appears), or for purposes of presenting tabular data.

Use the Common toolbar to insert tables into a page (or click Insert-Table from the menu bar).

Be at the location where you would like to insert the table - click the insert table icon

**The following window appears:**
**Table**

- **Table size**
  - Rows: 3
  - Columns: 3
  - Table width: 200 pixels
  - Border thickness: 0 pixels
  - Cell padding:
  - Cell spacing:

- **Header**
  - None
  - Left
  - Top
  - Both

- **Accessibility**
  - Caption:
  - Align caption: top
  - Summary:

**Specify**

- **Number of rows and columns** you wish

- **Table width** – can be pixels or percentages
  - **Pixels** provide a fixed width (size remains the same regardless of the browser size).
  - **Percentages** allow tables to grow or shrink, relative to space available.

- **Border thickness** (visible grid lines; if you wish no lines choose 0).

- **Cellpadding** – controls white space within cells (example on next page).

- **Cell spacing** – controls distance between cells (example next page).

- **Accessibility** – Enter a caption OR summary to assist with accessibility.
  - Captions will be viewable in the browser window;
  - Summaries will not be viewable in the browser window, but can be read by those using screen readers.

CLICK OK WHEN READY TO CONTINUE.

EXAMPLE OF CELLPADDING

**Without cellpadding:**

| First Row | Second Row |

**With cellpadding:**

| First Row | Second Row |

**Example of cellpadding:**

<table>
<thead>
<tr>
<th>First Row</th>
<th>Second Row</th>
<th>First Row</th>
<th>Second Row</th>
</tr>
</thead>
</table>

8/5/2008
Copyright, Office of Technology, Bloomsburg University
EXAMPLE OF CELL SPACING

Without cellspacing:  

With cellspacing:

Enter information into your table
Click into the cells to enter information

Editing a table
Click on the table so the entire table is selected - make changes in the Properties area (increase/decrease rows, columns, width, etc).
Another way to easily edit – adding columns or rows
Click in a table cell where you know you want to add either a row above or below, or a column to the left or right.

Right click and choose “Table – insert rows or columns” – fill out the window with the appropriate info you need to add a column or row.

Table Formatting
Click anywhere within a table and choose Commands-Format Table. There are many automatic formats available to choose from. Click the apply button to see the formats you choose. Click OK when done.

Meta tags – Make Your Pages Searchable
Inserting meta tag information into your pages can assist with browser search engines and help people find your pages. The content you add is not visible to web visitors as it coding embedded in your pages for search purposes. (Note: Some search engines do ignore meta tags.)

The two main features commonly used are Keywords and Description. (Note: There are other meta tags that can be used to redirect pages, specify copyright info, or refresh pages after a certain amount of days.)

To insert meta tab info, click Insert > HTML > Head Tags > Keywords (or Description) or use the Insert Toolbar as shown below:
Adding Description
Using either method mentioned above choose adding Description. The description text is what will be displayed on the search engine page so write well!

Insert > HTML > Head Tags > Description

The following window appears – type your text – example

Adding Keywords
Keywords are descriptive words that assist people using search engines. Think of the way you search and use keywords you think would assist people in finding your web site. **Hint:** Separate words by commas, don’t repeat words, keep the list short and specific to your site. Most reference books warn to only use 10-15 words tops.

Insert > HTML > Head Tags > Description

The following window appears – type your text – example below
Edit meta tag info

Probably the easiest way to edit meta tag info is to go into "split" view mode and make sure you scroll all the way to the top of your page. You will see the meta info on the screen. You may click right into the code view and make necessary changes.

```
<!-- TemplateBeginEditable name="head" -->
<meta name="Description" content="This is the official website for the Office of Technology at Bloomsburg University of Pennsylvania." />
<meta name="keywords" content="BU,Bloomsburg University,technology,office of technology" />
</head>
```